
Installation Guide



 

 

Document History 

Product Name Date 

Ipswitch Analytics Installation Guide - Beta 2 05/2015 

Ipswitch Analytics Installation Guide - Version 1.0.0 06/2015 

Copyright 

©1991-2015 Ipswitch, Inc. All rights reserved. 

This document, as well as the software described in it, is furnished under license and may be used or 

copied only in accordance with the terms of such license. Except as permitted by such license, no part of 

this publication may be reproduced, photocopied, stored on a retrieval system, or transmitted, in any form 

or by any means, electronic, mechanical, recording, or otherwise, without the express prior written consent 

of Ipswitch, Inc. 

The content of this document is furnished for informational use only, is subject to change without notice, 

and should not be construed as a commitment by Ipswitch, Inc. While every effort has been made to 

assure the accuracy of the information contained herein, Ipswitch, Inc. assumes no responsibility for errors 

or omissions. Ipswitch, Inc., also assumes no liability for damages resulting from the use of the 

information contained in this document. 

WS_FTP, the WS_FTP logos, Ipswitch, and the Ipswitch logo, MOVEit and the MOVEit logo, 

MessageWay and the MessageWay logo are trademarks of Ipswitch, Inc. Other products and their brands 

or company names, are or may be trademarks or registered trademarks, and are the property of their 

respective companies. 

 

This document was published on Thursday, June 04, 2015 at 03:17. 
 



 

 i 

 

Contents 

Introduction 1 

System Requirements ........................................................................................................................ 2 

Analytics Server Requirements ................................................................................................ 2 

Analytics Agent Requirements ................................................................................................. 5 

Web Browser and Additional Requirements ............................................................................ 6 

How Ipswitch Analytics Works ........................................................................................................... 7 

Configuration Options .............................................................................................................. 8 

Time Zones ............................................................................................................................. 15 

Security .................................................................................................................................. 16 

Get Help ........................................................................................................................................... 17 

Install 19 

Step 1: Gather Items ........................................................................................................................ 20 

Step 2: Install the Analytics Server ................................................................................................... 21 

Step 3: Sign in and Upload the License File ...................................................................................... 34 

Step 4: Install an Analytics Agent ..................................................................................................... 37 

Install Analytics Agents in High Availability Environments ..................................................... 46 

Step 5: Verify Agent Functionality .................................................................................................... 64 

Step 6: Configure the Ipswitch Analytics Server ............................................................................... 66 

Set the Global Password Policy .............................................................................................. 67 

Add User Accounts ................................................................................................................. 68 

Set up Email Notifications ...................................................................................................... 71 

Create a Ruleset ..................................................................................................................... 74 



 

ii Contents 

 

Create a User Group .............................................................................................................. 81 

Modify 87 

Modify the Ipswitch Analytics Server ............................................................................................... 88 

Modify an Ipswitch Analytics Agent ................................................................................................. 92 

Remove 101 

Remove the Ipswitch Analytics Server ........................................................................................... 101 

Remove and Reinstall the Ipswitch Analytics Server ............................................................ 103 

Remove an Ipswitch Analytics Agent ............................................................................................. 104 

 

  



 

 1 

 

Ipswitch Analytics™ is a web-based application for IT professionals that offers a single viewpoint into file 

transfer and processing activity on all of your MOVEit Central and DMZ servers. It is designed to be the 

system of record for all auditable activities that occur across your entire MOVEit system. Ipswitch 

Analytics captures transaction, processing and system data that may be located on MOVEit servers in 

different geographical regions and then presents that data in a web browser for analysis. 

Ipswitch Analytics's interactive Monitor graphs current high-level activity across one or more MOVEit 

servers to verify system status, identify file transfer impacts to business and discover actionable information 

for real-time response to issues. Ipswitch Analytics's customizable Reports show both detailed and 

high-level transfer and processing metrics across one or more MOVEit servers. Run reports on demand, or 

schedule reports for delivery to select business groups on a one-time or recurring basis. Transfer and 

Workflow reports provide a window into the transactions that occur on your MOVEit servers, and help 

identify file transfer impacts to business for planning purposes. User Audit and Security reports help 

administrators track user actions, failed logins and IP lockouts across multiple MOVEit servers and on the 

Ipswitch Analytics Server itself, providing the necessary tools to trace abusive or malicious activity within 

the enterprise.  

Ipswitch Analytics offers end-to-end visibility of critical business processes while providing IT departments 

with the tools they need to collect actionable business intelligence and provide audit trails to meet 

regulatory compliance. The simple-to-use and flexible web interface makes it easy to retrieve key 

performance metrics across multiple MOVEit systems using a single tool. 
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System Requirements 
Analytics Server Requirements (on page 2) 
Analytics Agent Requirements (on page 5) 
Web Browser and Additional Requirements (on page 6) 
 

Analytics Server Requirements 

Ipswitch Analytics Server Requirements 

System size (determined by number of 
Agents. One agent per MOVEit 
server/SQL database) 

Small Medium Large 

# of Analytics Agents  5 or fewer 6-10 11-20 

Minimum RAM1 4 GB 8 GB 16 GB 

Recommended RAM2 8 GB 16 GB 32 GB 

Hard disk drive3 1 TB 2 TB 4 TB 

CPU 4 Core 2.2 GHz  

Network Interface Card Gigabit Ethernet. The Ipswitch Analytics Server machine must 
have network access to the Ipswitch Analytics Agent.  

Windows Server OS 64-bit 2012 R2, 2012, 2008 R2 running on an administrator 
account 

Virtual Machine VMWare ESX 5, Hyper-V 2008, 2012 

1. The amount of RAM required depends on the number of MOVEit servers and their estimated number of monthly 
transactions. The Ipswitch Analytics Server installer tunes the Ipswitch Analytics PostgreSQL database 
automatically based on the RAM detected during installation.  

2. Recommended RAM improves user experience and query performance. 

3. The amount of hard drive space required depends on the number of MOVEit servers and their estimated number of 
monthly transactions. Higher numbers of transactions and/or tasks might require a larger hard drive. A transaction 
includes uploads, downloads, and Central steps. If you are not sure of your MOVEit activity level, see Estimating 
Monthly Transactions (on page 3). Recommended: 1 or 2 months after you install the Ipswitch Analytics server, 
check your system to verify that you have enough hard drive space to retain all of your data. 

The Ipswitch Analytics Server must be installed on a dedicated physical or virtual machine. Do not install the 
Ipswitch Analytics Server on a machine that hosts a MOVEit server or a MOVEit database. 
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Estimate Monthly Transactions 

It's important to install the Ipswitch Analytics Server on a machine that has the hardware capacity to 

properly handle the number of transactions that occur on your MOVEit DMZ and Central systems. If you 

cannot estimate the number of monthly transactions, follow the instructions below to calculate the average 

MOVEit DMZ transactions per month and the average MOVEit Central transactions per month. Add the 

two together, and then return to Hardware Requirements > Monthly MOVEit DMZ + MOVEit Central 

transaction estimate to select a size. 

Note: Complete the steps below for only the type of MOVEit servers on your system.  

MOVEit DMZ:  

1 Select a MOVEit DMZ server that is representative of a typical DMZ server on your system. 

Note: If you think the number of transfers varies widely on different MOVEit DMZ servers in your 

system, perform steps 2-3 for every MOVEit DMZ server. Do not complete step 5; instead, sum the 

average number of transactions from each DMZ server and then divide by the total number of DMZ 

servers. 

2 Sign in as sysadmin and create the following report to estimate that server's average transfers per month: 

 Report Category: File Transfer 

 Report Type: By Month 

 Start/End Date: Select the prior 12 months if available, or as many months as possible within the last 

year. 

3 Find the Total transfers per report time period by calculating the following: (Total number of Uploads x 2) 

+ Total number of Downloads. 

4 Find the Average number of transfers per month for this DMZ server by calculating the following: Total 

transfers per report time period number (calculated in step 3) / Number of months in the report.  

5 Find the Estimated Monthly MOVEit DMZ transactions by calculating the following: Average number of 

transfers per month x Number of MOVEit DMZ servers in your system.  

Note: Logins, logouts, and maintenance actions can be added as a factor when determining impact on the 

system but do not need to be calculated.  
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MOVEit Central: 

1 Select a MOVEit Central server that is representative of a typical Central server on your system. 

2 Select View > Reports. 

3 For Display, select File/Folder Activity.  

4 Click Edit Filter. 

5 On the File/Folder Activity tab, select the following: 

 Status is: Failure and Success 

 Action is: Upload, Download and Process 

 Display any file/folder activity entries with errors, regardless of action 

6 On the Date/Time tab, select Continuous date/time range and select the following: 

 Start Date: Enter a date 12 months prior to today.  

 End Date: Enter today's date. 

7 On the Limit tab, limit results to the 10,000 Newest. 

8 Click OK to run the report. The total number of transactions displays at the bottom right. If the total 

number of transactions shows 10000, select the Large system size. Otherwise, find the average number 

of MOVEit Central transactions by calculating the following: Total number of transactions x Number of 

MOVEit Central servers on your system. 
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Analytics Agent Requirements 

Ipswitch Analytics Agent Requirements 

1 GB of free disk space 

512 MB of free RAM 

Network connectivity with the MOVEit database and the Ipswitch Analytics Server. The Agent 

machine does not need network connectivity with the MOVEit server. 

One or more working MOVEit systems with On-maintenance: 

 MOVEit File Transfer Server (DMZ) 7.5, 8.0 or 8.1 

 MOVEit File Transfer (DMZ) High Availability and Disaster Recovery 7.5, 8.0 or 8.1 

 MOVEit Central 7.2, 8.0 or 8.1 

 MOVEit Central Failover 7.2, 8.0 or 8.1 

Supported MOVEit databases: 

 Microsoft SQL Server 2012 Standard/Enterprise (local or remote) 

 Microsoft SQL Server 2008 R2 Standard/Enterprise (local or remote) 

 Microsoft SQL Server 2008 Standard/Enterprise (local or remote) 

 MySQL 5.1.x - 5.5 (local only) 

It is recommended that you install the Agent on the same machine that hosts the MOVEit 

database. You can install only one Agent per machine (physical or virtual machine) and one 

Agent per SQL instance. 

(optional) Virtual machines running on: 

 VMware ESX (32-bit and 64-bit guest servers) 

 Microsoft Hyper-V (32-bit and 64-bit guest servers) 

 Hardware and software requirements for the virtual machine are the same. 

For more information on MOVEit Central and MOVEit DMZ hardware requirements, see: 

MOVEit DMZ Installation Guide 

(http://docs.ipswitch.com/MOVEit/DMZ8.1/manuals/MOVEit%20DMZ%20Installation%20Guide.pdf) 

MOVEit Central Installation Guide (http://www.ipswitch.com/moveit81installation) 
 

http://docs.ipswitch.com/MOVEit/DMZ8.1/manuals/MOVEit%20DMZ%20Installation%20Guide.pdf
http://www.ipswitch.com/moveit81installation
http://docs.ipswitch.com/MOVEit/DMZ8.1/manuals/MOVEit%20DMZ%20Installation%20Guide.pdf
http://www.ipswitch.com/moveit81installation
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Web Browser and Additional Requirements 

Supported Web Browsers 

Chrome 40 or 41 (Windows only) 

Microsoft Internet Explorer 10 or 11 (Windows only) 

Mozilla Firefox 36 or 37 (Windows, Mac, and RedHat Linux) 

Safari 7 or 8 (Mac only) 

Additional Requirements 

Adobe Reader is required to read exported PDF reports. 
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How Ipswitch Analytics Works 

Ipswitch Analytics consists of one or more Ipswitch Analytics Agents that pull data periodically from 

MOVEit databases and send that data securely to the Ipswitch Analytics Server. The Ipswitch Analytics 

Server stores the data in a PostgreSQL database and presents it for analysis within a web browser when 

requested.  

An Agent is required for each MOVEit database you want to include in Ipswitch Analytics. For example, if 

you have one MOVEit Central database and two MOVEit DMZ databases, you will need three Agents. 

The standard perpetual base Ipswitch Analytics license supports two Agents connected with a single Server, 

however, a Ipswitch Analytics Server can support up to 20 Agents and up to 100 users may sign in to the 

Ipswitch Analytics Server concurrently. Please visit How to Buy (http://www.ipswitchft.com/how-to-buy) to 

purchase add-on Agent licenses or to convert from an evaluation license to a perpetual license. 

Note: In a MOVEit Central High Availability environment, you install two Agents that use the same license 

but only one Agent is active at a time. See Install Ipswitch Analytics Agents in High Availability 

Enviornments (on page 46). 

The installation package contains a Ipswitch Analytics Server install file and a Ipswitch Analytics Agent 

install file.  

The Ipswitch Analytics Server 

The Ipswitch Analytics Server is a secure web server that uses Apache Tomcat to run as a Windows service. 

The Server receives data from each Agent periodically, consolidates that data into a dedicated PostgreSQL 

database that retains historical MOVEit data, and then presents that data in the form of reports and a 

real-time monitor within a web browser. Up to 100 users may sign in to the Ipswitch Analytics Server 

concurrently. 

Ipswitch Analytics Agents 

An Agent is a Windows service that periodically captures the most recent data from a MOVEit database, 

formats and encrypts that data, and then sends the data to the Ipswitch Analytics Server securely via 

HTTPS. Data collection occurs every one minute for Monitor data and every two minutes for Reports. 

Agents have a small software footprint and use simple read-only queries that have minimal impact on 

MOVEit processing. The Agent's access to the MOVEit database is controlled by credentials entered during 

Agent installation. The Ipswitch Analytics Agent service typically runs on the Agent machine as an 

administrator user specified during installation, or in the context of the standard "LocalService" or 

"NetworkService" account.  

 
 

http://www.ipswitchft.com/how-to-buy
http://www.ipswitchft.com/how-to-buy
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Configuration Options 

Before installing Ipswitch Analytics, evaluate your current MOVEit system to determine the best 

installation configuration for your organization. Your organization's MOVEit servers may be located on 

stand-alone machines, separate from their MOVEit databases, or both MOVEit Server and MOVEit 

database may be installed on the same machine. Your organization may have numerous MOVEit servers, or 

perhaps only one or two MOVEit servers.  

Consider the following components when deciding how to install Ipswitch Analytics within your existing 

MOVEit system: 

 The Ipswitch Analytics Server: You must install the Server on a standalone machine. The Server 

installation includes the installation of a dedicated PostgreSQL database. 

 Ipswitch Analytics Agents: You must install one Agent for each MOVEit database that you want to 

include in the Ipswitch Analytics environment for analysis. You can install an Agent on any machine 

that has network access to the MOVEit database; the Agent machine does not need network access to 

the MOVEit server. The Agent must also have network access to the Ipswitch Analytics Server, but 

cannot be installed on the Ipswitch Analytics Server. You can install only one Agent per machine (bare 

metal or virtual machine), and one Agent per SQL instance. 

 MOVEit Central Servers and Databases 

 MOVEit DMZ Servers and Databases 

Below are some sample Ipswitch Analytics installation configurations. Each sample configuration includes 

only one MOVEit Central server and only one MOVEit DMZ server for demonstration purposes. Your 

system could have a different number of MOVEit servers. You can choose a different configuration for each 

MOVEit server if desired.  

Note: The sample configurations show only three web browsers connecting to the Ipswitch Analytics Server, 

but the Ipswitch Analytics Server can support up to 100 concurrent web client users. 
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MOVEit server, MOVEit database and Ipswitch Analytics Agent installed on same machine: 

 

MOVEit server installed on a separate machine, with MOVEit database and Ipswitch Analytics Agent 

installed on the same machine:  
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MOVEit server, MOVEit database and Ipswitch Analytics Agent installed on separate standalone 

machines: 

 

The following four configurations show MOVEit DMZ and MOVEit Central installed on standalone 

machines with both MOVEit SQL Server databases sharing a third standalone machine.  

One Agent installed on the SQL Server database machine and one Agent installed on a standalone 

machine (physical or virtual): 
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Both Agents installed on standalone machines (physical or virtual): 

 

One Agent installed on the SQL Server database machine, the other Agent installed on a MOVEit server: 
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An Agent installed on each MOVEit server: 
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MOVEIT DMZ WEB FARMS 

If your MOVEit DMZ system is set up as a Web Farm, it contains only one MOVEit database. Install only 

one Agent, either on the Web Farm database machine, or on a separate machine that has a network 

connection connects to the Web Farm database machine. 

MOVEit DMZ Web Farm database connected to multiple MOVEit DMZ servers. Ipswitch Analytics 

Agent installed on same machine as Web Farm database: 

 

MOVEit DMZ Web Farm database connected to multiple MOVEit DMZ servers. Ipswitch Analytics 

Agent installed on a separate standalone machine that connects to the Web Farm database: 
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MOVEIT CENTRAL HIGH AVAILABILITY (HA) 

If your MOVEit Central system is set up for High Availability (HA), you will have a primary server and a 

secondary (failover) server that activates only if the primary server fails. Below are the two possible 

configuration options for installing Ipswitch Analytics into a MOVEit Central HA environment. Dotted 

lines indicate dormant connections. 

Single Microsoft SQL Server Database 

MOVEit Central primary and secondary servers point to the same Microsoft SQL Server database on a 

standalone machine. Install one Agent on the MOVEit Central Microsoft SQL Server database machine. 
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Two Local MySQL Databases 

In this scenario, the primary and secondary servers point to their own local MySQL databases. Install 

Agents on each MOVEit Central server. You can use a single Agent license for both the primary and 

secondary Agents since only one database will send data to the Agent at a time.  

 
 

Time Zones 

Ipswitch Analytics Agents may collect data from multiple servers located in different geographic locations. 

When the Ipswitch Analytics Server receives a data record from an Agent, it converts the timestamp of that 

record to GMT (Greenwich Mean Time) before presenting it in a report. All queries also convert user-input 

times to GMT. 
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Security 

The following security methods are in place for Ipswitch Analytics: 

Passwords 

Ipswitch Analytics uses the Advanced Encryption Standard (AES) to protect the passwords used to grant 

access to Ipswitch Analytics, and to protect access to the MOVEit database and the Ipswitch Analytics 

Server.  

 Ipswitch Analytics Agent: The only sensitive data that the Agents store  is the password to access the 

MOVEit DMZ/Central database tables and the Ipswitch Analytics Agent password to access the 

Ipswitch Analytics Server. The MOVEit database password is protected using standards-based, 

bi-directional AES256 encryption. The MOVEit database password is entered in plaintext during the 

install process and is encrypted before being stored in the configuration. When establishing a connection 

to the MOVEit database, the password is decrypted and passed to the JDBC driver. Internally, the JDBC 

driver encrypts the password using a value supplied by the database server before it is transmitted to the 

server for authentication. The plaintext password is never transmitted or stored. 

 Ipswitch Analytics Server: The Ipswitch Analytics Server stores passwords for locally authenticated 

Ipswitch Analytics users and SMTP server login passwords. These passwords are protected using a 

one-way secure salted hash. When a local user is added to the system, the password that is entered in 

plain text will be hashed and stored in the database. When a local user attempts to sign in, the password 

that is supplied will be hashed and the resulting hash will be compared with the stored hash and the user 

will be authenticated if they are equal. When a local user password is changed, the new password must 

be entered twice. These two passwords will be compared against each other and if they are equal, the 

new password will be hashed and stored in the database. System Administrators can also set minimum 

and maximum password size and a password strength policy ranging from Very Tough to Almost None. 

Note: Report data is not considered sensitive and is not encrypted in the database nor on the file system of 

the servers that generate the reporting data or on the Ipswitch Analytics Server.  

All authentication information used by Ipswitch Analytics is encrypted or hashed. Encryption and hashing 

are done using the Java Simplified Encryption library (Jasypt). Details of the Jayspt library can be found at 

www.jayspt.org. For Ipswitch Analytics, hashing is done using the SHA-512 algorithm and utilizes the 

Jasypt library to enhance the protection using random salts and multiple iterations of the hashing function. 

Bi-directional encryption is done using Jasypt to provide password-based encryption. The password is based 

on a random number generated by the Ipswitch Analytics Server at install. 
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Data Transmission 

Communication between the Ipswitch Analytics Agents and the Ipswitch Analytics Server uses HTTPS, so 

data is always encrypted during transmission. 

Communication between the web client browser and the Ipswitch Analytics Server uses HTTPS, so data is 

always encrypted during transmission. 

Certificates 

Certificates are used for encryption of communications. The Ipswitch Analytics Server supports the use of 

certificates issued by a Certificate Authority and also supports the use of self-signed certificates. 

When the Ipswitch Analytics Server is installed, a keystore is created and the certificates required for secure 

communication between the Ipswitch Analytics Agents and the Ipswitch Analytics Server and also between 

the client browser and the Ipswitch Analytics Server are added to the keystore. 

 
 

Get Help 

There are two ways for you to get help with Ipswitch Analytics: 

 At the top of the screen, click about and select one of the following: 

User's Guide (for Partners, Monitors, Readers and Creators): Includes instructions for using Ipswitch 

Analytics. 

Administrator's Guide (for System Administrators and Administrators). Includes instructions for 

installing, managing and using Ipswitch Analytics.  

 Visit the Ipswitch support website (http://www.ipswitchft.com/support). On the main Support page 

you'll find links to all documentation and help videos, a form to submit a support request, and customer 

support telephone numbers.  
 

http://www.ipswitchft.com/support
http://www.ipswitchft.com/support
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Below is a high-level view of the installation process. Click any item to view instructions for that step. 

 

Install 
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Step 1: Gather Items 
Print the installation worksheet below. Prior to installation, gather the items in the Pre-installation 
Checklist. As you install the product, add your input values to the list. 

 
Next: Step 2: Install the Analytics Server (on page 21) 
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Step 2: Install the Analytics Server 

This topic shows you how to install the Ipswitch Analytics Server. You must install the Ipswitch Analytics 

Server on a dedicated physical or virtual machine. A PostgreSQL database will be installed on this 

machine as part of the Ipswitch Analytics Server installation. Do not install the Ipswitch Analytics Server 

on a machine that hosts a MOVEit server or a MOVEit database. 

You do not have to stop your MOVEit server(s) to install the Ipswitch Analytics Server.  

High Availability Environments: If you want to install Ipswitch Analytics in a MOVEit Central High 

Availability environment with primary and secondary (failover) databases, first Install the Ipswitch 

Analytics Server below, then Install Ipswitch Analytics Agents in High Availability Environments (on 

page 46). 

1 Sign in as an Administrator on a Windows Server machine. This will be the account under which all 

Ipswitch Analytics Server processing occurs. 

2 Download the Ipswitch Analytics Server install file: Ipswitch_Analytics_Base_v1.exe 

3 Open Ipswitch_Analytics_Base_v1.exe. 

4 If the machine does not have all of the prerequisite software installed, you may see this screen: 

 

Click Install to install these necessary items. 
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The installer opens. Click Next. 

 

5 Accept the license agreement and click Next. 
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6 Select a Destination Folder where all Ipswitch Analytics Server installation files will install. By 
default, the Ipswitch Analytics Server installs into c:\Program Files\Ipswitch\Analytics Server. Click 
Change... to select a different directory.   

Caution: Do not specify a destination on a drive that is mapped to a network drive. 

Note: You will set a location for the Ipswitch Analytics Server database files in a later step. 

 
Click Next. 
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7 Enter the Analytics Server Settings. These settings allow System Administrator login access to the 

Ipswitch Analytics server. 

 System Administrator Username: Enter the name of a user who will have access to all of Ipswitch 

Analytics. This user will be the only System Administrator initially. The default name is sysadmin.  

 System Administrator Password: Enter a password for the System Administrator. Valid passwords 

must be between 8 and 20 characters in length, contain at least one number and one non-number, 

and must not contain the System Administrator Username.  

 System Administrator Email Address (and confirmation): Enter an email address for the System 

Administrator. 

 

The size of your system is indicated on this screen also. The installer detects your RAM size 

automatically to make the determination: 4 GB: Small, 8 GB: Medium, or 16 GB: Large.  

Click Next. 
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8 Enter the Agent Access Settings: 

 Agent Access Username: This is the name that all Ipswitch Analytics Agents will use when 

authenticating with the Ipswitch Analytics Server. The default name is "feeder" (allowed 

characters: 'a'-'z', '0'-'9' and '_'). This user account is only for Agent access to the Ipswitch 

Analytics Server. This username will display in the Users module once you sign in to Ipswitch 

Analytics. 

Tip: You can change the Agent Access Username from the Users module after installation, but 

you'll also need to modify the Agent install (on page 92) for changes to take effect. 

 Agent Access Password (and confirmation): Enter a password for the Agent to use when 

authenticating with the Ipswitch Analytics Server. 

Note: This password uses standards-based, bi-directional AES256 encryption. The password is 

entered in plaintext during the install process and is encrypted before being stored in the 

configuration. The password will never be transmitted and it will only be stored in encrypted 

form. 

IMPORTANT: Write down the Agent Access username and password. You will need these when 

you install an Agent (on page 37). This username will appear later as a user in the Users module, 

but it is used only for Agent access to the Ipswitch Analytics Server. If you change this Agent 

name or password later in the Users module, you must modify the Agent (on page 92) as well. 

 

Click Next. 
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9 Enter Tomcat Settings:  

 HTTPS Connector Port: Ipswitch Analytics Server is configured to accept HTTPS connections on 

port 8443 by default. Adhere to your IT security or other IT network policies when configuring 

ports.  

 Ipswitch Analytics Server URL: This is the URL of the Ipswitch Analytics Server, and must be in 

the format https://hostname or IP address:port/ura. The value that you enter for hostname or IP 

address must match the Common Name (CN) in your imported keystore certificate.  

 For self-signed certificates: The value that you enter for hostname or IP address will be used 

for the certificate's common name.  

 For certificate imports: Specify the fully qualified domain name here. For example, to use a 

*.ipswitch.com certificate, enter https://analytics.ipswitch.com:8443/ura. 

 

IMPORTANT: Write down this information in the Installation Worksheet.  

Click Next. The HTTPS Connector Port will be validated. 
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10 Specify the Tomcat Service User Logon Information. Do you want to use an account other than the 

Local System account to sign in and run the Ipswitch Analytics Server service? 

 No (default): Use the Local System account to sign in and run the Ipswitch Analytics Server 

service. This will be the account you used to log on to Windows.  

 Yes: Specify a different account to sign in and run the service, then click Next. Enter a User name, 

Password and Group of the user account that will sign in to run the Ipswitch Analytics Server 

service. 

 

Click Next. 
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11 Select a Tomcat Certificate option for the Ipswitch Analytics Server to validate identity certificates. 

 

 Create Self-Signed Certificate (for Evaluation Accounts only): This certificate will expire in 30 

days. Enter a Password for this certificate that is between 8 to 20 characters in length, contains 

only alphanumeric characters, and contains at least one number, one lower-case letter, and one 

upper-case letter. Click Next. 

 Import Certificate Keystore: Import an SSL password-protected PKCS12 certificate keystore file 

with .PFX or .P12 file extension. Click Browse to locate the certificate keystore. The server 

certificate, private key and chain certificate are generated from this PKCS12 keystore.  

IMPORTANT: If you import a certificate keystore that fails, you will not be notified of that fact 

during installation, and you will not be able to access the Ipswitch Analytics Server. To fix the 

certificate keystore, you need to update the certificates by modifying the Ipswitch Analytics 

Server (on page 92). If you select Import Certificate Keystore, click Next and enter the Password 

(and confirmation) for the keystore.  
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12 Select a Database Location for the Ipswitch Analytics Server's PostgreSQL database. MOVEit data 

collected from all Agents will feed into this database. The default location is C:\ProgramData\PGData\. 

It is recommended that you keep the default location, however, you may click Change... to select a 

different location.  

IMPORTANT: If you select a different database location, it must be a data-specific directory that is not 

limited to a single user.  

 

Click Next.   
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13 Enter the Ipswitch Analytics Database Settings. This information is required to run the PostgreSQL 

database on the Ipswitch Analytics Server. A PostgreSQL database will be installed on this machine as 

part of the Ipswitch Analytics Server installation.  

 Admin Username: This account is not used by the Ipswitch Analytics Server at all, but is created so 

that a database administrator can access the PostgreSQL database if necessary. It is recommended 

that you keep the suggested Admin Username. 

 Admin Password (and confirmation): Enter a password for the Admin user. Valid passwords must 

be 8 to 20 characters in length, contain only alphanumeric characters, and contain at least one 

number and one non-number, and must not contain the username.  

 Access Username: This is the account that the Ipswitch Analytics Server web application will use 

to access the PostgreSQL database, both to insert data that arrives from the Ipswitch Analytics 

Agents, and to retrieve report and monitor data for display. It is recommended that you keep the 

suggested Access Username. 

 Access Password (and confirmation): Enter a password for the Access user. Valid passwords must 

be 8 to 20 characters in length, contain only alphanumeric characters, and contain at least one 

number and one non-number, and must not contain the username.  

 Database Port: This port number is predefined to the standard PostgreSQL port, but you can 

change this to any unused port if desired (the installer will notify you if the port is already in use). 

 

Note: Both the Admin and Access users will be able to access the PostgreSQL database using 

PostgreSQL tools; however, there should not be any need for you to access to PostgreSQL.  
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14 Review the installation settings, and then click Install. 

 

After a few moments, the installation completes.  

Optional: Click Show the Windows Installer log to view installation details after the installation 

completes. 

Tip: You can view the install log later in the Temp directory 
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15 Click Finish. 

 

Copy the URL displayed in Next Steps. This is the Analytics Server URL. You will need it to 

complete the next Step. The URL in the image above is an example only.  
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If you opted to view the installer log, it will open automatically and look like this: 

 

Next: Step 3: Sign in and Upload the License File (on page 34) 
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Step 3: Sign in and Upload the License File 

1 On the Analytics Server machine, open the Ipswitch Analytics Server shortcut: 

 Windows Server 2008: Click Start > All Programs > Ipswitch Analytics Server > Ipswitch Analytics 

Server. 

 Windows Server 2012: Open c:\Program Files\Ipswitch\Analytics Server\AnalyticsServer.url. 

The Sign in page displays: 

 

Troubleshooting: If the Ipswitch Analytics sign in page does not open, explore the possible causes 

below. 

 The Ipswitch Analytics Server machine may be shut down or be in the process of restarting.  

 On the Ipswitch Analytics Server machine, go to the Control Panel > Administrative Tools > 

Services to verify that the Ipswitch Analytics Server service is running. The service may have 

stopped running due to an unexpected application crash or a planned stoppage of the Tomcat 

service. 

 Internet connectivity on the web browser machine or on the Ipswitch Analytics Server may be 

down in general. 

 You may have entered a PKCS12 keystore certificate in an unsupported format during Ipswitch 

Analytics Server installation. The installer does not validate imported certificates. Try modifying 

the installation and select a keystore certificate with a .PFX or .P12 extension. 



 

 Install 35 

 

2 (Optional) If users will access the Analytics Server from outside the corporate firewall, go to an 

external computer not connected to your network, open a web browser (on page 2) and enter the 

Analytics Server URL in the address bar. If you are unable to connect to the Analytics Server from the 

external computer, you may need to configure your firewall to open the port.  

3 Sign in using the System Administrator user name and password you created during the Ipswitch 

Analytics Server installation (on page 21). The main Ipswitch Analytics workspace appears: 

 

As System Administrator, you have access to the entire Ipswitch Analytics system. 

Troubleshooting: if you are not able to sign in, explore the possible causes below. 

 Verify that you entered the correct username and password on the sign in screen 

 On the Ipswitch Analytics Server machine, go to the Control Panel > Administrative Tools > 

Services and verify that the IpswitchPostgresql service is running. The service may not be running 

due to an unexpected application crash or a planned stoppage of the service. 
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4 Go to the Settings module and select the Licensing tab. 

 

5 Click Upload License and browse to select the license file you were given. The Base Serial Number 

populates with a long alpha-numeric number, and the following items update: 

 # Licenses: The number of Agent licenses allowed by your license. The base Ipswitch Analytics 

license includes two Agent licenses that can be connected to either MOVEit server type; additional 

licenses are specific to the MOVEit server type.  

 # Available: The number of unused Agent licenses. Initially this number will match the number of 

licenses. When you install an Agent, the Agent will claim one of the available licenses. 

The Licenses list below displays all Agent licenses available for use.  

See Licensing (https://docs.ipswitch.com/MOVEit/Analytics1.0/Help/Admin/index.htm#28525.htm) for 

more information on connecting and disconnecting Agents to a MOVEit database. Visit How to Buy 

(http://www.ipswitchft.com/how-to-buy) to purchase add-on Agent licenses. 

Next: Step 4: Install an Analytics Agent (on page 37) 
 

https://docs.ipswitch.com/MOVEit/Analytics1.0/Help/Admin/index.htm#28525.htm
http://www.ipswitchft.com/how-to-buy
https://docs.ipswitch.com/MOVEit/Analytics1.0/Help/Admin/index.htm#28525.htm
http://www.ipswitchft.com/how-to-buy
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Step 4: Install an Analytics Agent 

For MOVEit Central High Availability Environments (failover): See Install Analytics Agents in High 

Availability Environments (on page 46). 

You must install the Ipswitch Analytics Server (on page 21) before installing an Agent. Install an Agent 

for each MOVEit database that you want to include in the Ipswitch Analytics environment. Install only 

one Agent per machine. It is recommended that you install an Agent on the machine that hosts the 

MOVEit database, but you may also install it on any machine that has network connectivity with the 

MOVEit database. See Sample Installation Configurations (on page 8) for help deciding where to install 

the Agent in your existing MOVEit system. Ipswitch Analytics does not support environments where 

MOVEit DMZ and MOVEit Central are installed on the same machine. 

Each Ipswitch Analytics Agent uses one license. The standard Ipswitch Analytics package comes with two 

Agent licenses. To add another MOVEit server to the Ipswitch Analytics system later, simply install 

another Agent and purchase an add-on Agent license. Please visit How to Buy 

(http://www.ipswitchft.com/how-to-buy) to purchase add-on Agent licenses. 

The machine that hosts the MOVEit database must be online and network accessible before you begin an 

Agent installation. You do not have to stop the MOVEit server to install an Agent. Agent installation will 

not significantly affect MOVEit DMZ and Central system performance. 

1 Retrieve the public certificate file for the Ipswitch Analytics Server. There are two ways to do this: 

 On the Agent machine: Point a browser to the Ipswitch Analytics Server IP address or hostname 

and accept the certificate. Go into your browser's settings to manage certificates and export the 

public certificate associated with the Ipswitch Analytics Server. The exported certificate must be 

in one of the following file formats: .pem, .cer, .crt or .der. Place the exported certificate on the 

Agent machine's desktop or easily accessible file location. 

 On the Ipswitch Analytics Server machine: Copy c:\Program Files\Ipswitch\Analytics 

Server\apache-tomcat-7\certs\servercert.pem and place it on the Agent machine's desktop or other 

easily accessible location. 

2 Sign in to a machine where you want to install the Agent using an account with administrator 

privileges. It is recommended that you install the Agent on the machine that hosts the MOVEit 

database. In some cases, this is also the machine that hosts the MOVEit DMZ or Central server. 

3 Download the appropriate Ipswitch Analytics Agent install file: 

 64-bit: Ipswitch_Analytics_Agent64_v1.exe 

 32-bit: Ipswitch_Analytics_Agent32_v1.exe  

http://www.ipswitchft.com/how-to-buy
http://www.ipswitchft.com/how-to-buy
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4 Open the Ipswitch Analytics Agent installation file. Click Next. 

 

5 Read the License Agreement and accept the terms. Click Next. 

6 Select a Destination Folder. By default, the Agent installs into c:\Program Files\Ipswitch\Analytics 

Agent. Click Change... to select a different directory. Click Next. 

7 Enter the Analytics Server Settings. The Agent will forward data from the MOVEit server to the 

Ipswitch Analytics Server that you specify here. 

 Ipswitch Analytics Server IP address or hostname: (From the Tomcat Settings) For example, if you 

entered https://analytics:8443/ura for Ipswitch Analytics Server URL during installation of the 

Ipswitch Analytics Server, enter analytics. 

 Port: By default the Ipswitch Analytics Server is configured to accept HTTPS connections on port 

8443. Adhere to your IT security or other IT network policies when configuring ports.  

 Agent Access Username: Enter the username for the Agent to access the Ipswitch Analytics Server 

(see Installation Worksheet). This user will have the role "Ipswitch Analytics Agent" and no name 

or email is associated with it.  

 Agent Access Password (and confirmation): See Installation Worksheet. 
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Click Next. 

8 Enter the Analytics Agent Truststore Settings: 

 Analytics Server public certificate file: Browse to select the public certificate file that you located in 

the first step of the Agent installation. It will have the extension .pem, .cer, .crt, or .der. 

 Truststore password: Enter the truststore password for the certificate. Write down this password 

and keep it safe. You will need it if you ever plan to modify the Agent installation (on page 92).  

The installer will create the ‘ipswitchcerts’ truststore in /jre/lib/security.   

Important: Do not use the .p12 or .pfx certificate file that you used during installation of the Ipswitch 

Analytics Server. If you select a certificate file that does not have the proper file format, the 

installation will roll back at the point when Ipswitch Analytics files install to the disk and the 

certificate attempts to import to the truststore. 



 

40 Ipswitch Analytics Installation Guide  

 

 

Click Next. 

9 If the machine on which you are installing the Agent does not contain an installation of MOVEit 

Central or DMZ, select the MOVEit server type for which you are installing this Agent.   

 

Click Next. 
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10 Enter the MOVEit Database Settings.  

 Database Type: Select either MySQL or Microsoft SQL Server, depending on the type of database 

used by the MOVEit server you selected in the prior step. 

 Authentication Type (SQL Server only): Select the authentication type used for logon to the SQL 

Server. The currently used authentication type will be selected automatically. 

 Windows: SQL Server logon will use Windows authentication. If selecting this option, 

username must be entered in the DOMAIN\User format. 

 SQL: SQL Server logon uses a separate user/password created specifically for logon to the 

SQL Server database. 

 Database Name: The name of the MOVEit database. This will be pre-populated if installing the 

Agent on the same machine as the MOVEit server. 

 Hostname or IP Address: The location of the MOVEit database. If the MOVEit database is on the 

same machine as the MOVEit server, this will be localhost. If the MOVEit database and MOVEit 

server are on separate machines, this will be the Hostname or IP address of the machine where the 

database is located. If installing on a machine with no MOVEit DMZ or Central, the default 

database name will appear here (such as moveitdmz).  

Note: If installing the Agent on a machine that contains an SQL Server database with multiple 

instances on the same server, Hostname or IP Address will prepopulate with the default value 

used by MOVEit Central or DMZ (for example, localhost\instance1). You can also enter a 

different instance. If the machine does not contain MOVEit DMZ or Central, the instance name 

will not prepopulate but must be entered manually.  

 Port: The port used to connect with the MOVEit database. The installer suggests a port number, 

but you may change the port number if necessary to match the port used by the MOVEit database. 

This will be pre-populated if installing the Agent on the same machine as the MOVEit server. If 

installing on a machine with no MOVEit DMZ or Central, the default port will appear here. 

Note: If the MOVEit database is using a non-standard port number, you will need to remove the 

default port number shown and replace it with the non-standard port number.  

 Username and Password: The username and password that allows access to the MOVEit database. 

For an SQL Server database: The Authentication Type selected above will determine what user 

credentials you enter here. Windows authentication requires that the username be in the 

DOMAIN\User format. 

Tip: If you can't locate the username and password to the MOVEit database, look in 

c:\MOVEitDMZ_Install.INI file (DMZ) or c:\MOVEitCentral_Install.INI file (Central). 
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Note: The MOVEit database password is protected using standards-based, bi-directional AES256 

encryption. The MOVEit database password is entered in plaintext during the install process and 

is encrypted before being stored in the configuration. When establishing a connection to the 

MOVEit database, the password is decrypted and passed to the JDBC driver. Internally, the JDBC 

driver encrypts the password using a value supplied by the database server before it is transmitted 

to the server for authentication. The plaintext password is never transmitted or stored. 

 

Click Next. 

Tip: If the connection to the database fails, check that your firewall is open.  
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11 Enter the Analytics Agent Settings.  

 Agent Display Name: Enter a name that will identify this MOVEit server within Ipswitch Analytics. 

This name will appear in the Monitor dashboard and in reports. You may want to use the name of 

the MOVEit server so it will be easy for users to recognize data coming from this MOVEit server 

within the Ipswitch Analytics interface.  

 Is this a new or existing agent? Select an option: 

 Installing a new agent with a new name: The Agent Display Name has never been registered 

with the Ipswitch Analytics Server before. Agent display name must not be a repeat of an 

existing Agent Display Name on the Ipswitch Analytics Server.  

 Installing an agent already known to Analytics Server: An Agent was previously installed and 

registered with the same name and you want to use that Agent's name. Agent Display Name 

will be the same as the original Agent Display Name. 

Note: If this Agent is already known to the Analytics Server, you must install it on the same 

type of MOVEit server. For example, if the Agent was installed on a MOVEit Central server in 

the past and you wish to reuse the Agent Display Name, you must install it on a MOVEit 

Central server again. 

 Do you want to include historical data that already exists on the MOVEit server? 

 Include Historical Data: Ipswitch Analytics will include historical data from this MOVEit 

server.  

 Start with current data: Ipswitch Analytics reports will include data from this point forward 

only, and will not include any past data from this MOVEit server.  

Note: You may want some MOVEit servers to include historical data but not others. Each Agent is a 

separate installation so you can select a different option here for each MOVEit agent. 
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Click Next. 

12 Review the installation setup.Click Install if you are happy with the installation setup, or click Back to 

make changes to the setup. 
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Note: If you click Cancel now, the install stops but the Agent installation folder will remain in the 

install directory you selected. You can safely delete the Analytics Agent directory to remove any files 

that linger after an interruption of the install process. 

To view the installer log that includes detailed information about every step of the installation process, 

click Show the Windows Installer log. You can also view the install log at a later point at c:\log.log.  

13 Click Finish to complete the install. 

 

Installation of the Agent is complete. The Ipswitch Analytics Agent service is now running on this 

machine and will immediately begin reporting data to the Ipswitch Analytics Server. To disconnect 

this Agent, see Licensing in the Ipswitch Analytics Administrator's Guide. 

Repeat these steps if necessary to install another licensed Agent for a different MOVEit database. 

Note: If you opted to include historical data during Agent installation, it may take the Agent a few 

minutes to a few hours to retrieve that historical data and send it to the Ipswitch Analytics Server, 

depending on the amount of data in the MOVEit database. During this time, the MOVEit server will 

continue to be operational and you can begin using Ipswitch Analytics, but since the data capture is a 

trickle process, you will not see all historical data until the historical data capture process is complete. 

You will not be notified when the Agent finishes pulling all historical data, but you can verify that the 

historical data capture process is complete by running a report for a time range in the past.  

Next: Step 5: Verify Agent Functionality (on page 64) 
 

https://docs.ipswitch.com/MOVEit/Analytics1.0/Help/Admin/index.htm#28525.htm
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Install Analytics Agents in High Availability Environments 

This topic shows you how to install Ipswitch Analytics Agents in a MOVEit High Availability (HA) 

environment that includes a primary database and a secondary (failover) database. You must install the 

Ipswitch Analytics Server (on page 21) before proceeding. 

In a MOVEit Central High Availability environment, you install two Agents that use the same license, but 

only one Agent is active at a time.  

You can install the Agents on the machine that hosts the MOVEit database, or on any machine that has 

network connectivity with the MOVEit database.  

If your MOVEit Central system is set up for High Availability (HA), you will have a primary server and a 

secondary (failover) server that activates only if the primary server fails. Below are the two possible 

configuration options for installing Ipswitch Analytics into a MOVEit Central HA environment. Dotted 

lines indicate dormant connections. 

Single Microsoft SQL Server Database 

MOVEit Central primary and secondary servers point to the same Microsoft SQL Server database on a 

standalone machine. Install one Agent on the MOVEit Central Microsoft SQL Server database machine. 
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Two Local MySQL Databases 

In this scenario, the primary and secondary servers point to their own local MySQL databases. Install 

Agents on each MOVEit Central server. You can use a single Agent license for both the primary and 

secondary Agents since only one database will send data to the Agent at a time.  

 

The machine that hosts the MOVEit database must be online and network accessible before you begin an 

Agent installation. You do not have to stop the MOVEit server to install an Agent. Agent installation will 

not significantly affect MOVEit DMZ and Central system performance. 

First you must install an Agent for the PRIMARY database machine and then install an Agent for the 

SECONDARY database machine: 

Install a Primary Agent (on page 47)  

Install a Secondary Agent (on page 55) 
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Install a Primary Agent 

1 Retrieve the public certificate file for the Ipswitch Analytics Server. There are two ways to do this: 

 On the Agent machine: Point a browser to the Ipswitch Analytics Server IP address or hostname 

and accept the certificate. Go into your browser's settings to manage certificates and export the 

public certificate associated with the Ipswitch Analytics Server. The exported certificate must be 

in one of the following file formats: .pem, .cer, .crt or .der. Place the exported certificate on the 

Agent machine's desktop or easily accessible file location. 

 On the Ipswitch Analytics Server machine: Copy c:\Program Files\Ipswitch\Analytics 

Server\apache-tomcat-7\certs\servercert.pem and place it on the Agent machine's desktop or other 

easily accessible location. 

2 Sign in to a machine where you want to install the Agent using an account with administrator 

privileges. It is recommended that you install the Agent on the machine that hosts the MOVEit 

database. In some cases, this is also the machine that hosts the MOVEit DMZ or Central server. 

3 Download the appropriate Ipswitch Analytics Agent install file: 

 64-bit: Ipswitch_Analytics_Agent64_v1.exe 

 32-bit: Ipswitch_Analytics_Agent32_v1.exe  

4 Open the Ipswitch Analytics Agent installation file. Click Next. 
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5 Read the License Agreement and accept the terms. Click Next. 

6 Select a Destination Folder. By default, the Agent installs into c:\Program Files\Ipswitch\Analytics 

Agent. Click Change... to select a different directory. Click Next. 

7 Enter the Analytics Server Settings. The Agent will forward data from the MOVEit server to the 

Ipswitch Analytics Server that you specify here. 

 Ipswitch Analytics Server IP address or hostname: (From the Tomcat Settings) For example, if you 

entered https://analytics:8443/ura for Ipswitch Analytics Server URL during installation of the 

Ipswitch Analytics Server, enter analytics. 

 Port: By default the Ipswitch Analytics Server is configured to accept HTTPS connections on port 

8443. Adhere to your IT security or other IT network policies when configuring ports.  

 Agent Access Username: Enter the username for the Agent to access the Ipswitch Analytics Server 

(see Installation Worksheet). This user will have the role "Ipswitch Analytics Agent" and no name 

or email is associated with it.  

 Agent Access Password (and confirmation): See Installation Worksheet. 

 

Click Next. 
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8 Enter the Analytics Agent Truststore Settings: 

 Analytics Server public certificate file: Browse to select the public certificate file that you located in 

the first step of the Agent installation. It will have the extension .pem, .cer, .crt, or .der. 

 Truststore password: Enter the truststore password for the certificate. Write down this password 

and keep it safe. You will need when you install an Agent for the secondary failover HA 

database (on page 55), and if you ever have to modify the Agent installation (on page 92). 

The installer will create the ‘ipswitchcerts’ truststore in /jre/lib/security.   

Important: Do not use the .p12 or .pfx certificate file that you used during installation of the Ipswitch 

Analytics Server. If you select a certificate file that does not have the proper file format, the 

installation will roll back at the point when Ipswitch Analytics files install to the disk and the 

certificate attempts to import to the truststore. 

 

Click Next. 

9 If the machine on which you are installing the Agent does not contain an installation of MOVEit 

Central or DMZ, select MOVEit Central from the drop-down menu: 
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Click Next. 

10 Enter the MOVEit Database Settings.  

 Database Type: Select either MySQL or Microsoft SQL Server, depending on the type of database 

used by the MOVEit server you selected in the prior step. 

 Authentication Type (SQL Server only): Select the authentication type used for logon to the SQL 

Server.  

 Windows: SQL Server logon will use Windows authentication. If selecting this option, 

username must be entered in the DOMAIN\User format. 

 SQL: SQL Server logon uses a separate user/password created specifically for logon to the 

SQL Server database. 

 Hostname or IP Address: The location of the MOVEit primary database. If it is on the same 

machine as the MOVEit server, this will be localhost. If the MOVEit primary database and 

MOVEit server are on separate machines, this will be the hostname or IP address of the machine 

where the primary database is located.  If installing on a machine that does not contain MOVEit 

Central, the default database name will appear here (such as micstats).  

Note: If installing the Agent on a machine that contains an SQL Server database with multiple 

instances on the same server, Hostname or IP Address will prepopulate with the default value 

used by MOVEit Central (for example, localhost\instance1). You can also enter a different 

instance. If the machine does not contain MOVEit Central, the instance name will not prepopulate 

but must be entered manually.  

 Port: The port used to connect with the MOVEit primary database. The installer suggests a port 

number, but you may change the port number if necessary to match the port used by the MOVEit 

primary database. This will be pre-populated if installing the Agent on the same machine as the 

MOVEit Central server. If installing on a machine that does not contain MOVEit Central, the 

default port will appear here. 

Note: If the MOVEit primary database is using a non-standard port number, you will need to 

remove the default port number shown and replace it with the non-standard port number.  
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 Username and Password: The username and password that allows access to the MOVEit primary 

database. If the primary database is an SQL Server database, the Authentication Type selected 

above will determine what user credentials you enter here. Windows authentication requires that 

the username be in the DOMAIN\User format. 

 Password: The password required to sign in with the username above.  

Tip: If you can't locate the username and password to the MOVEit database, look in 

c:\MOVEitCentral_Install.INI file. 

Note: The MOVEit database password is protected using standards-based, bi-directional AES256 

encryption. The MOVEit database password is entered in plaintext during the install process and 

is encrypted before being stored in the configuration. When establishing a connection to the 

MOVEit database, the password is decrypted and passed to the JDBC driver. Internally, the JDBC 

driver encrypts the password using a value supplied by the database server before it is transmitted 

to the server for authentication. The plaintext password is never transmitted or stored. 

 

Click Next. 

Tip: If the connection to the database fails, check that your firewall is open.  
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11 Enter the Analytics Agent Settings.  

 Agent Display Name: Enter a name that will identify this MOVEit Central server within Ipswitch 

Analytics. This name will appear in the Monitor dashboard and in reports. You may want to enter 

the MOVEit Central name in this name so it will be easy for users to identify data coming from 

this MOVEit server within the Ipswitch Analytics interface later.  

 Is this a new or existing agent? Select an option: 

 Installing a new agent with a new name: The Agent Display Name has never been registered 

with the Ipswitch Analytics Server before. Agent display name must not be a repeat of an 

existing Agent Display Name on the Ipswitch Analytics Server.  

 Installing an agent already known to Analytics Server: An Agent was previously installed and 

registered with the same name and you want to use that Agent's name. Agent Display Name 

will be the same as the original Agent Display Name. 

Note: If this Agent is already known to the Analytics Server, you must install it on the same 

type of MOVEit server. For example, if the Agent was installed on a MOVEit Central server in 

the past and you wish to reuse the Agent Display Name, you must install it on a MOVEit 

Central server again. 

 Do you want to include historical data that already exists on the MOVEit server? 

 Include Historical Data: Ipswitch Analytics will include historical data from this MOVEit 

server.  

Start with current data: Ipswitch Analytics reports will include data from this point forward 

only, and will not include any past data from this MOVEit server.  

 

Click Next. 
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12 Review the installation setup.Click Install if you are happy with the installation setup, or click Back to 

make changes to the setup. 

 

Note: If you click Cancel now, the install stops but the Agent installation folder will remain in the 

install directory you selected. You can safely delete the Analytics Agent directory to remove any files 

that linger after an interruption of the install process. 

To view the installer log that includes detailed information about every step of the installation process, 

click Show the Windows Installer log. You can also view the install log at a later point at c:\log.log.  
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13 Click Finish to complete the install. 

 

Installation of the primary Agent is complete. The Ipswitch Analytics Agent service is now running on 

this machine and will immediately begin reporting data to the Ipswitch Analytics Server. To 

disconnect this Agent, see Licensing in the Ipswitch Analytics Administrator's Guide. 

Next, Install an Secondary Agent (on page 55) 
 

https://docs.ipswitch.com/MOVEit/Analytics1.0/Help/Admin/index.htm#28525.htm
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Install a Secondary Agent 

Important: You must Install an Agent for the Primary HA Database (on page 47) before proceeding. 

1 Sign in to a machine where you want to install the SECONDARY Agent using an account with 

administrator privileges. Recommendation: Install the Agent on the machine that hosts the MOVEit 

database. 

2 Copy the public certificate file for the Analytics Server from the primary Agent machine to the 

secondary Agent machine. Place it on the secondary Agent machine's desktop or other easily 

accessible location. You located this file in Step 1 of Install a Primary Agent (on page 47).  

3 Open the appropriate Ipswitch Analytics Agent install file: 

 64-bit: Ipswitch_Analytics_Agent64_v1.exe 

 32-bit: Ipswitch_Analytics_Agent32_v1.exe  

Click Next. 
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4 Read the License Agreement, select I accept the terms in the license agreement, and then click Next. 

5 Select a Destination Folder.  

By default, the Agent installs into c:\Program Files\Ipswitch\Analytics Agent. To install the Agent in a 

different directory, click Change... and select the desired directory. 

When you are happy with the Destination Folder selection, click Next. 

6 Enter the Analytics Server Settings. The Agent will forward data from the MOVEit secondary database 

to the Ipswitch Analytics Server that you specify here. 

 Ipswitch Analytics Server IP address or hostname: (From the Tomcat Settings) For example, if you 

entered https://analytics:8443/ura for Ipswitch Analytics Server URL during installation of the 

Ipswitch Analytics Server, enter analytics. 

 Port: By default the Ipswitch Analytics Server is configured to accept HTTPS connections on port 

8443. Adhere to your IT security or other IT network policies when configuring ports.  

 Agent Access Username: Enter the username for the Agent to access the Ipswitch Analytics Server 

(see Installation Worksheet). This user will have the role "Ipswitch Analytics Agent" and no name 

or email is associated with it.  

 Agent Access Password (and confirmation): See Installation Worksheet. 

 

Click Next. 
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7 Enter the Analytics Agent Truststore Settings: 

 Analytics Server public certificate file: Browse to select the public certificate file that you located at 

the beginning of the Agent installation. It will have the extension .pem, .cer, .crt, or .der. 

 Truststore password: Enter the same truststore password you entered for the Primary Agent 

installation. 

The installer will create the ‘ipswitchcerts’ truststore in /jre/lib/security.   

Important: Do not use the .p12 or .pfx certificate file that you used during installation of the Ipswitch 

Analytics Server. If you select a certificate file that does not have the proper file format, the 

installation will roll back at the point when Ipswitch Analytics files install to the disk and the 

certificate attempts to import to the truststore. 

 

Click Next. 

8 If the machine on which you are installing the Agent does not contain an installation of MOVEit 

Central or DMZ, select MOVEit Central from the drop-down menu: 

 

Click Next. 
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9 Enter the MOVEit Database Settings.  

 Database Type: Select either MySQL or Microsoft SQL Server, depending on the type of database 

used by the MOVEit server you selected in the prior step. 

 Authentication Type (SQL Server only): Select the authentication type used for logon to the SQL 

Server.  

 Windows: SQL Server logon will use Windows authentication. If selecting this option, 

username must be entered in the DOMAIN\User format. 

 SQL: SQL Server logon uses a separate user/password created specifically for logon to the 

SQL Server database. 

 Database Name: The name of the secondary MOVEit database. This will be pre-populated if 

installing the Agent on the same machine as the MOVEit Central server. 

 Hostname or IP Address: The location of the secondary MOVEit database. If it is on the same 

machine as the MOVEit server, this will be localhost. If the secondary MOVEit secondary and 

MOVEit server are on separate machines, this will be the hostname or IP address of the machine 

where the secondary database is located. If installing on a machine that does not contain MOVEit 

Central, the default database name will appear here (such as micstats).  

Note: If installing the Agent on a machine that contains an SQL Server database with multiple 

instances on the same server, Hostname or IP Address will prepopulate with the default value 

used by MOVEit Central or DMZ (for example, localhost\instance1). You can also enter a 

different instance. If the machine does not contain MOVEit DMZ or Central, the instance name 

will not prepopulate but must be entered manually. .  

 Port: The port used to connect with the secondary MOVEit database. The installer suggests a port 

number, but you may change the port number if necessary to match the port used by the MOVEit 

secondary database. This will be pre-populated if installing the Agent on the same machine as the 

MOVEit Central server. If installing on a machine that does not contain MOVEit Central, the 

default port will appear here. 

Note: If the primary MOVEit database is using a non-standard port number, you will need to 

remove the default port number shown and replace it with the non-standard port number.  

 Username and Password: The username and password that allows access to the secondary MOVEit 

database. If the secondary database is an SQL Server database, the Authentication Type selected 

above will determine what user credentials you enter here. Windows authentication requires that 

the username be in the DOMAIN\User format. 

Tip: If you can't locate the username and password to the MOVEit database, look in 

c:/MOVEitCentral_Install.INI file (Central). 
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Note: The MOVEit database password is protected using standards-based, bi-directional AES256 

encryption. The MOVEit database password is entered in plaintext during the install process and 

is encrypted before being stored in the configuration. When establishing a connection to the 

MOVEit database, the password is decrypted and passed to the JDBC driver. Internally, the JDBC 

driver encrypts the password using a value supplied by the database server before it is transmitted 

to the server for authentication. The plaintext password is never transmitted or stored. 

 

Click Next. 

Tip: If the connection to the database fails, check that your firewall is open.  
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10 Enter the Analytics Agent Settings: 

 Primary Agent Name: Enter the primary Agent's Agent Display Name. You entered this value in the 

final step of the PRIMARY Agent's installation. 

 Is this a new or existing agent?: This item is disabled. 

 Would you like to include historical data? Select Start with current data.  

 

Click Next. 
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11 Review the installation setup.Click Install if you are happy with the installation setup, or click Back to 

make changes to the setup. 

 

Note: If you click Cancel now, the install stops but the Agent installation folder will remain in the 

install directory you selected. You can safely delete the Analytics Agent directory to remove any files 

that linger after an interruption of the install process. 

To view the installer log that includes detailed information about every step of the installation process, 

click Show the Windows Installer log. You can also view the install log at a later point at c:\log.log.  
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12 Click Finish to complete the install. 

 

Installation of the secondary Agent is complete. The secondary Ipswitch Analytics Agent service is now 

running on this machine but will only report data to the Ipswitch Analytics Server if the primary 

database fails. This secondary Agent will not display in Settings > Licensing unless the primary 

database fails.  

Note: If you opted to include historical data during Agent installation, it may take the Agent a few 

minutes to a few hours to retrieve that historical data and send it to the Ipswitch Analytics Server, 

depending on the amount of data in the MOVEit database. During this time, the MOVEit server will 

continue to be operational and you can begin using Ipswitch Analytics, but since the data capture is a 

trickle process, you will not see all historical data until the historical data capture process is complete. 

You will not be notified when the Agent finishes pulling all historical data, but you can verify that the 

historical data capture process is complete by running a report for a time range in the past.  

Next: Step 5: Verify Agent Functionality (on page 64) 
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Step 5: Verify Agent Functionality 

After signing in, you should test the ability of Ipswitch Analytics Agents to retrieve data from their 

MOVEit databases and send that data to the Ipswitch Analytics Server: 

In the web browser where you signed in earlier, navigate to the Monitor module: 

 

The top of the workspace contains a Dashboard that displays all Agents that you installed. Verify that all 

Agents are Online  and sending data to the Ipswitch Analytics Server.  
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Troubleshooting: If any Agent's status is Unknown  or Offline , explore the possible causes below: 

 The MOVEit database machine may be shut down or be in the process of restarting.   

 The MOVEit database service may have stopped running. This could be due to an unexpected 

application crash or a planned stoppage of the database service. On the MOVEit database machine, go 

to the Control Panel > Administrative Tools > Services. Depending on the MOVEit database, make sure 

either the Microsoft SQL Server or the MySQL service is running. 

 The Agent machine may be shut down or be in the process of restarting.   

 The Ipswitch Analytics Agent service may have stopped running on the Agent machine. This could be 

due to an unexpected application crash or a planned stoppage of the Ipswitch Analytics Agent service. 

On the Agent machine, go to the Control Panel > Administrative Tools > Services. Verify that the 

Ipswitch Analytics Agent service is running. 

 Internet connectivity may be down in general on the Agent machine or the MOVEit database machine. 

 The Agent machine may not have network access to the MOVEit database machine or the Ipswitch 

Analytics Server machine due to firewall restrictions on those machines. 

 The password that the Agent uses to access the MOVEit database may have expired or have been 

changed. Follow the steps in the Installation Guide to modify an Agent Installation (on page 92) to 

update the username and/or password to the MOVEit database. 

 The HTTPS port on the Agent machine, the MOVEit database machine and/or the Ipswitch Analytics 

Server machine may not be open. Follow the steps in the Installation Guide to modify an Agent 

installation (on page 92) and modify the Ipswitch Analytics Server installation (on page 88) to update 

the port numbers for the MOVEit database machine and/or the Ipswitch Analytics Server machine. 

If an Agent does not appear appear in the dashboard at all: 

 Modify the Agent installation and make sure you enter the correct password for the Agent to access 

the Ipswitch Analytics Server on the Analytics Server Settings screen.  

 Check the Agent log on the Agent machine, located at c:\Program Files\Ipswitch\Analytics 

Agent\logs\agent.log to see if the Agent is able to receive data from the MOVEit database, authenticate 

with the Ipswitch Analytics Server and send data to the Ipswitch Analytics Server. 
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Sample Agent.log: 

 

To release an Agent license to use with a different MOVEit server, see the Ipswitch Analytics 

Administrator's Guide > Manage > Licensing. 

Next: Step 6: Configure the Analytics Server (on page 66) 
 

Step 6: Configure the Ipswitch Analytics Server 

Complete each of the following steps to configure the Analytics Server for the first time.  

1 Set the Global Password Policy (on page 67). 

2 Add user accounts (on page 68). 

3 If you plan to allow scheduled report delivery to email addresses, Set Up Email Notifications (on page 

71). 

4 Optionally Create a Ruleset (on page 74) to: 

 Block Creators from viewing and selecting specific MOVEit servers, organizations and 

usernames in the Templates Filter. 

 Limit a scheduled report to include only specific MOVEit servers, organizations and 

usernames. 

5 Optionally Create a User Group (on page 81) to: 

 Allow only a specific group of users to view and/or manage a Library report 

 Deliver a scheduled report to a specific group of users 
 

https://docs.ipswitch.com/MOVEit/Analytics1.0/Help/Admin/index.htm#28525.htm
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Set the Global Password Policy 

The default password policy requires that all Ipswitch Analytics user passwords: 

 Be a minimum of eight characters 

 Be a maximum of 20 characters 

 Follow the Sturdy password policy: a password cannot be the username or a shorter version of it, 

cannot contain dictionary words, and must contain at least one numeric and one non-numeric character 

To keep this policy, proceed to the next step: Add User Accounts. To select a stronger or weaker password 

policy, follow the steps below. 

1 Go to the Analytics Server URL and sign in as System Administrator 

2 Go to the Settings module and select the System tab.  

3 Select Password Policy. 

4 Select a password policy from the list of built-in user password policies, with strengths from low to 

high: 

 Very Tough: Password cannot contain or be a short version of the username and cannot contain 

popular dictionary words. Password must contain at least one numeric character, one non-numeric 

character, one special character (such as $ or !), and contain uppercase and lowercase letters. 

 Tough: Password cannot contain or be a short version of the username and cannot contain popular 

dictionary words. Password must contain at least one numeric and one non-numeric character, and 

contain both uppercase and lowercase letters. 

 Sturdy (Default): Password cannot contain or be a short version of the username and cannot 

contain popular dictionary words. Password must contain at least one numeric and one 

non-numeric character. 

 Minimal: Password cannot contain or be short version of the username. Password must contain at 

least one numeric and one non-numeric character. 

 Weak: Password cannot contain or be short version of the username. 

 Almost None: Password cannot be the same as username. 

5 For User password minimum size, enter the minimum number of characters the password must be.  

6 For User password maximum size, enter the maximum number of characters the password can be. 

For more information on user password security measures in place with Ipswitch Analytics, see 

Security (on page 16). 

Next: Add User Accounts (on page 68) 
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Add User Accounts 

Access to Ipswitch Analytics requires a user account. Ipswitch Analytics user accounts are not connected 

to MOVEit user accounts.  

Note: The same user can sign in to Ipswitch Analytics at multiple locations. Users can also share the same 

email address. 

1 Open the Users module. 

 

Note: The feeder username is used only for Agent access to the Ipswitch Analytics Server. It has the 

role of Ipswitch Analytics Agent and no name or email is associated with it. If you entered a different 

name for the Agent Access Username during Agent installation, it will show a different name. If you 

change the Agent Access Username or password here, you must modify the Agent (on page 92) and 

change it there also. 
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2 Click Add User. The New user screen displays: 

 

3 Enter a unique alphanumeric Username. Duplicate names are not allowed, but you can reuse the name 

of a user who has been deleted. Names are case-sensitive.  

4 Select a Role for the user using the drop-down list next to username. The user's Role controls access to 

Ipswitch Analytics modules and Ipswitch Analytics report types. Ipswitch Analytics comes with six 

predefined user roles: 

 Partner: This user can only view Transfer and Workflow reports in the Library. 

 Monitor: This user can only view the Monitor. 

 Reader: This user can view the Monitor and Transfer and Workflow reports in the Library. 

 Creator: This user can create reports in the Templates and Schedule tabs. Creators can also view 

the Monitor and can view Transfer and Workflow reports in the Library. A ruleset can limit the 

MOVEit sources that a Creator can access when creating and running templates and creating 

schedules.  

 Administrator: This user has access to all Ipswitch Analytics modules except the Settings > System 

tab, and can view all report types, including User Audit and Security reports. This user can create 

rulesets, and can assign rulesets to schedules as an additional layer of MOVEit source control. 

 System Administrator: This user has full access to everything in Ipswitch Analytics. Only a System 

Administrator can manage all system settings and access all areas of Ipswitch Analytics. 
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The table below summarizes the permissions granted to each user role. Ipswitch Analytics modules 

display at the top of the table. 

 

Follow your organization's accepted security practices when assigning roles. 

5 Beneath Password, a suggested password displays.  

 

To have the system suggest a different password, click Generate. A new randomly-generated password 

appears in the Password box. You can also click Change to create a custom password.  
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6 Optional: Enter a Firstname and Lastname for the user. 

7 Enter the user's Email address. This is where the user will receive email notifications when scheduled 

reports are ready for viewing. The email address does not have to be unique; multiple users can share 

the same email address. 

8 Click Save. 

9 Give the following information to users so they can sign in to Ipswitch Analytics: 

 Ipswitch Analytics Server IP address or hostname 

 Username 

 Password 

Next: Set Up Email Notifications (on page 71) 
 

Set up Email Notifications 

If you want users to receive email notification when a scheduled report is ready for viewing, you must 

configure email notifications first.  

1 Go to the Settings module. 

2 Select the System tab.  

3 Check Enable Email Notifications (this is unchecked by default). The email notification settings 

become editable. 
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4 Enter the following information: 

 Host Name: Host name or IP address of the SMTP server. This is the server that will deliver the 

outgoing email messages. For example: smtptest.ipswitch.com or 192.168.1.1. 

 Port: 25 is the default.  

 Enable Authentication: This box must be checked to allow email notifications.  

 Username and Password: The login credentials for the SMTP server. 

 Enable STARTTLS: STARTTLS is a popular protocol used to communicate with the SMTP server. 

Most modern SMTP servers support it because it can use the same port for encryption. If set, and a 

socket factory hasn't been specified, this enables the use of a MailSSLSocketFactory. When 

Enable STARTTLS is checked, enter values for the following: 

 Hosts to trust for SSL connection: Enter the host name or IP address of the hosts you want to 

trust. Wildcards are accepted ("*" will trust all hosts). Enter multiple hosts separated by 

spaces. 

 Socket connection timeout in milliseconds: 10,000 is the default timeout, but you may want to 

set this higher if you have a slow network. 

 Socket I/O timeout in milliseconds: 30,000 is the default timeout, but you may want to set this 

higher if you have a slow network. 

 Enable HTML email (optional): Sends email notifications in HTML format. If unchecked, email will 

be sent in plain text only.  

 From email address: Enter an email address from which notifications will be sent. 

Note: Supported email clients are: Gmail, Microsoft Outlook and Apple Mail. 

5 Click Save. 

You can also click Reset to return to the original default Notifications settings. 

Note: If the Save button is not enabled, make sure you've completed all items in the prior step. 
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EMAIL SAMPLES: 

HTML email: 

 

Plain text email: 

 

Next: Create a Ruleset (on page 74) 
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Create a Ruleset 

Your system may contain one or more MOVEit servers. Each MOVEit server contains one or more 

organizations, and each organization contains multiple users. These are your MOVEit data sources. 

When users create a new template or edit an existing template in the Template Editor, a Filter displays all 

of your MOVEit sources by default. Users can include all MOVEit sources in a template, or select specific 

MOVEit sources to include, and even save their Filter selections as a custom template. If that template is 

then used as the basis for a scheduled report, the scheduled report will exclude any MOVEit data sources 

not allowed by that template's Filter.  

To further restrict access to your MOVEit sources, you can create a ruleset that allows access to only 

specific MOVEit sources. After you create a ruleset, you can assign the ruleset to a:  

 User Group: When working in the Template Editor, Creator members of the group will be blocked 

from viewing and selecting any MOVEit source not allowed by the ruleset. The Template Editor's 

Filter will display only the allowed MOVEit sources for selection. 

 Schedule: Only Administrators and System Administrators can assign a ruleset to a schedule to 

provide an additional layer of MOVEit source control over scheduled report results.  

When both a filter and a ruleset are in place (for example, if the template used to create a schedule has 

specific Filter settings AND a ruleset is assigned to the schedule), they combine to include only the 

MOVEit sources allowed by both filter and ruleset. 

Rulesets do not affect anything in the Monitor or any report that already resides in the Reports Library. 

You must create a ruleset before you can assign it to a user group or schedule. Only Administrators and 

System Administrators can create rulesets in the Settings module.  
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 To create a ruleset: 

1 Open the Settings module.  

 

The Rulesets tab displays. No rulesets display initially, however, after you create rulesets they will 

display in this window. You'll see each ruleset's Name, Description, the last user to update it (Updated 

by), and when it was last Updated. You can also select and delete a ruleset rom this window. 

2 Click Create. 

The New ruleset window displays. 

 

All available MOVEit sources display on the left, and the Ruleset name and Description display on the 

right.  
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3 Enter a Ruleset Name and an optional Description on the right. 

4 On the left, select a Filter that will limit data to only the MOVEit sources you select. 

The Filter drop-down menu lets you select the type of MOVEit source you want to view: Servers, 

Organizations or Usernames. The source list below updates to reflect your selection.  

For example, if you select Filter Usernames, the source list displays all usernames from All 

Organization(s) across your MOVEit system. The total count of items in the source list displays next to 

the selected MOVEit source type. In the example below, 18 usernames display in the list.   

 

Note: Servers is the default MOVEit source type initially. All MOVEit servers to which you have 

access display in the list of Servers below.  

Use the Search box to locate a specific server, organization or username in the source list when it 

contains a large number of items (the asterisk wildcard is accepted). Enter any portion of the name to 

view all results that contain that string. 
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To display only usernames from specific organizations, click All Organization(s), select the 

organizations to include and click Ok.  

 

In this example, notice that only two organizations are selected. The source list of usernames now 

contains only 13 items from 2 Organization(s). 
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Similarly, if you selected Organizations for the Filter type, the source list will display all organizations 

from All Server(s) across your MOVEit system. To display only organizations that belong to specific 

servers, click All Server(s), select the servers to include and click Ok.  

Remember, MOVEit sources are nested: a server contains organizations that contain usernames: 

 

You can filter only one level above the current filter type. You cannot, for example, show in the 

source list only Usernames from specific Servers.  

Tip: You can select a filter type even if the template does not include that data field. For example, you 

can select the Usernames filter even if the eventual report does not contain the Username field. 

Tip: If you don't see a server, organization or username known to exist on your system, a MOVEit 

administrator may have added it recently. Sign out of Ipswitch Analytics and then sign in again.  

Note: The Ipswitch Analytics Server displays as a server option for Administrators and System 

Administrators only. 
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5 Once you've customized the source list to your satisfaction, select individual items to include in the 

ruleset. Remember, this ruleset will allow only these specific MOVEit sources.   

 

Note: Selecting no items is the same as selecting all items in the list. However, if you select one or 

more items in the list, only the items you select will be allowed by the ruleset and any items not 

explicitly selected will be denied.  

Warning: If you select a different filter (Server, Organization or Username) after selecting items from 

the list, your selections will be lost. 

Note: To include data for a single server that has had two different names in the past, you must select 

both server names in the Filter.  
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Use the Search box above the list to locate a specific server, organization or username within the list 

(the asterisk wildcard is accepted). Enter any portion of the name to view all results that contain that 

string. This is useful when there is a large number of items in the list, such as organizations that 

contain hundreds of usernames.  

 

6 Click Save after you've selected all MOVEit source items to include in the ruleset.  

After you create a ruleset, Administrators and System Administrators can assign it to user groups and to 

schedules. For more information, consult the Ipswitch Analytics Administrator's Guide > Manage > User 

Groups and Schedules. 

Next: Create a User Group (on page 81) 
 

http://www.ipswitch.com/analytics01adminhelp
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Create a User Group 

Create a user group if you want to: 

 Allow only a specific group of users to view and/or manage a Library report 

 Deliver a scheduled report to a specific group of users 

 Limit Creators within a user group to seeing in the Template Editor only those MOVEit sources 

allowed by the ruleset assigned to the user group 

A user does not have to belong to any user group; user group membership is optional.  

A user group includes the following data: 

 Use Group Name 

 Description 

 Ruleset (optional). A ruleset blocks Creator users from viewing and selecting specific MOVEit 

servers, organizations and usernames in the Template Editor. 

 User members of the group 

User groups are located in the Users module under the Groups tab.  
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Only users with the role of System Administrator or Administrator can create and manage user groups. 

Creators have read-only access to the Groups tab. 

All user groups display in the left panel, and the users that belong to the selected user group display in the 

right panel. Ipswitch Analytics comes with only one user group initially: Everyone. The Everyone user 

group contains all Ipswitch Analytics users.  

 

If a user group has a ruleset assigned to it, you'll see a lock next to the user group name. Hover your 

mouse over the lock to see the ruleset assigned to that user group.  
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 To create a user group: 

1 Go to the Users module and select the Groups tab. 

 

2 Click Create. 

3 Enter a Group name and Description. 
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4 Optional: Select a Ruleset for the group. A ruleset blocks Creators from viewing and working with 

specific MOVEit servers, organizations and users in the Templates and Schedule tabs. You can select 

only one ruleset per user group. 

 

Note: A ruleset must be created before you will see it in this list. 

5 Click Create.  

The new group appears in the User Groups list on the left. 
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If you assigned a ruleset, you'll see a lock icon next to the user group name. Hover your mouse over 

the lock icon to see what ruleset is assigned to that user group. 

 

6 Now you can add users to the user group. Click Add User(s)... 
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7 Click inside the Select Users box to select one or more users from the list that appears.  

Note: Only users who are not already members of the group will appear here. 

 

Note: A user group can contain 0 or more users.  

8 Click Save.  

The user adds to the username list on the right. You can now select this user group as a schedule 

recipient, and grant Library report access to this user group. 

 

Note: You can also select a user group and click Delete to remove that group, or click Edit to add or 

remove members from the group. 
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After you've installed Ipswitch Analytics, you may need to modify the Ipswitch Analytics Server or an 

Ipswitch Analytics Agent installation to make changes to the original setup.  

You may want to modify an Ipswitch Analytics Server installation (on page 88) to change:  

 Tomcat settings:  

 HTTPS Connector Port 

 Ipswitch Analytics Server IP address or hostname (Analytics Server URL) 

 Tomcat Service Logon Account 

 Tomcat SSL certificate option (self-signed or certificate keystore) 

 Certificate passwords, or certificate keystore import 

 Analytics Server Database settings:  

 Admin username and password 

 Access username and password 

 Port 

You may want to modify an Ipswitch Analytics Agent installation (on page 92) to change: 

 The Ipswitch Analytics Server IP address or hostname and/or port number 

 The Agent Access Username and/or Password that the Agent uses to gain access to the Ipswitch 

Analytics Server 

 The Ipswitch Analytics Server public certificate file and/or password 

 The MOVEit Database Type, Authentication Type, IP address or hostname, Database Name, Port 

number, or login credentials used to access the MOVEit database (this may be required if your 

corporate security policy expires passwords after a set amount of time) 

 The Agent Display Name (the name of the Agent as it appears in Ipswitch Analytics) 

Important: If you upgrade a MOVEit server after installing an Agent on it, you must run the Agent install 

program on that server again and select Modify so the Agent will detect the proper MOVEit version 

number. If you fail to do so, the older server version number will be reported in Ipswitch Analytics.   

 

Modify 
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Modify the Ipswitch Analytics Server 

You can modify the Ipswitch Analytics Server to update: 

 Tomcat settings:  

 HTTPS Connector Port 

 Ipswitch Analytics Server IP address or hostname (Analytics Server URL) 

 Tomcat Service Logon Account 

 Tomcat SSL certificate option (self-signed or certificate keystore) 

 Certificate passwords, or certificate keystore import 

 Analytics Server Database settings:  

 Admin username and password 

 Access username and password 

 Port 

You do not have to stop your MOVEit server(s) or any of the Agents to modify the Ipswitch Analytics 

Server. 

Note: You can change the System Administrator's name and password via the User's module.  

1 Before you modify a Ipswitch Analytics Server setting, stop all Ipswitch Analytics Agents. Go to each 

Agent machine and under Administrative Tools select Services. Right-click Ipswitch Analytics Agent 

and select Stop. 

2 Sign in to the Ipswitch Analytics Server machine using an account with administrator privileges. 

3 Do one of the following: 

 Open Ipswitch_Analytics_Base_v1.exe.  

 Open Control Panel > Uninstall a program, select Ipswitch Analytics Server and click Change. 

The installer opens. 

4 Click Next. 

5 Select Modify. 

6 Select a category to modify: 

 Tomcat: Modify the HTTPS Connector Port, Tomcat SSL certificate option (self-signed or 

certificate keystore), and certificate passwords.  

 Database: Modify the database's admin username, admin password, access username, access 

password, and database port. 

7 Click Next. 
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8 Modify items in the category you selected:  

Tomcat: 

Tomcat Settings: 

 HTTPS Connector Port: The installer suggests a port number, but you may change it if necessary. 

The Ipswitch Analytics Server is configured to accept HTTPS connections on port 8443 by 

default. Adhere to your IT security or other IT network policies when configuring ports.  

 Ipswitch Analytics Server IP URL: This will be the URL of the Ipswitch Analytics Server, and must 

be in the format https://hostname or IP address:port/ura. The value that you enter for hostname or 

IP address must match the Common Name (CN) in your imported keystore certificate.  

 For self-signed certificates: The value that you enter for hostname or IP address will be used 

for the certificate's common name.  

 For certificate imports: Specify the fully qualified domain name here. For example, to use a 

*.ipswitch.com certificate, enter https://analytics.ipswitchft.com:8443/ura. 

 

Tomcat Service Logon Account: 

Do you want to use an account other than the Local System account to sign in and run the Ipswitch 

Analytics Server service? 

 No (default): Use the Local System account to sign in and run the Ipswitch Analytics Server 

service. This will be the account you used to log on to Windows.  

 Yes: Specify a different account to sign in and run the service, then click Next to advance to the 

next screen. Enter a User name, Password and Group of the user account that will sign in to run the 

Ipswitch Analytics Server service. 
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Tomcat Certificate: 

Specify how you want the Ipswitch Analytics Server to validate identity certificates:  

 

 Create Self-Signed Certificate (for Evaluation Accounts only): This certificate will expire in 30 

days. Enter a Password for this certificate that is between 8 to 20 characters in length, contains 

only alphanumeric characters, and contains at least one number, one lower-case letter, and one 

upper-case letter. Click Next. 

 Import Certificate Keystore: Import an SSL password-protected PKCS12 certificate keystore file 

with .PFX or .P12 file extension. Click Browse to locate the certificate keystore. The server 

certificate, private key and chain certificate are generated from this PKCS12 keystore.  

IMPORTANT: If you import a certificate keystore that fails, you will not be notified of that fact 

during installation, and you will not be able to access the Ipswitch Analytics Server. To fix the 

certificate keystore, you need to update the certificates by modifying the Ipswitch Analytics 

Server (on page 92). If you select Import Certificate Keystore, click Next and enter the Password 

(and confirmation) for the keystore.  
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Database: 

Specify the Analytics Server Database Settings. This information is required to run the PostgreSQL 

database on the Ipswitch Analytics Server: 

 Admin Username: This account is not used by the Ipswitch Analytics Server at all, but is created so 

that a database administrator can access the PostgreSQL database if necessary. It is recommended 

that you keep the suggested Admin Username. 

 Admin Password (and confirmation): Enter a password for the Admin user. Valid passwords must 

be 8 to 20 characters in length, contain only alphanumeric characters, and contain at least one 

number and one non-number, and must not contain the username.  

 Access Username: This is the account that the Ipswitch Analytics Server web application will use 

to access the PostgreSQL database, both to insert data that arrives from the Ipswitch Analytics 

Agents, and to retrieve report and monitor data for display. It is recommended that you keep the 

suggested Access Username. 

 Access Password (and confirmation): Enter a password for the Access user. Valid passwords must 

be 8 to 20 characters in length, contain only alphanumeric characters, and contain at least one 

number and one non-number, and must not contain the username.  

 Database Port: This port number is predefined to the standard PostgreSQL port, but you can 

change this to any unused port if desired (the installer will notify you if the port is already in use). 

 

Note: Both the Admin and Access users will be able to access the PostgreSQL database using 

PostgreSQL tools; however, there should not be any need for you to access to PostgreSQL.  



 

92 Ipswitch Analytics Installation Guide  

 

9 When you've completed making the necessary modifications, click Install. 

10 After the modify process completes, optionally select Show the Windows Installer Log. 

11 Click Finish. 
 

Modify an Ipswitch Analytics Agent 

Note: To change the Agent Access Username or password, change it first in the Ipswitch Analytics 

interface by editing the Ipswitch Analytics Agent user. Then run Modify below to change the Agent 

Access Username on all machines that have Agents that send data to the Ipswitch Analytics Server. 

Important: During modification of the Agent you will be required to enter the original truststore password 

you entered during Agent installation. If you cannot remember that original password, you must first 

delete the truststore file from the Agent machine you are modifying, located at c:\Program 

Files\Ipswitch\Analytics Agent\jre7\lib\security\ipswitchcerts before proceeding.  

The machine that hosts the MOVEit database must be online and network accessible before you begin an 

Agent modification. You do not have to stop the MOVEit server to modify an Agent. Agent modification 

will not significantly affect MOVEit DMZ and Central system performance. 

1 If you need to modify the Ipswitch Analytics Server IP address or hostname, first complete the 

following steps. Otherwise, go to step 2. 

1. Sign in on the Agent machine with administrator privileges.  

2. Go to Administrative Tools and select Services. Right-click Ipswitch Analytics Agent and select 

Stop to stop the Agent service. 

3. Sign in on the Ipswitch Analytics Server machine.  

4. Modify the Ipswitch Analytics Server (on page 88) installation to make the necessary changes to 

the Ipswitch Analytics Server IP address or hostname. 

5. Return to the Agent machine and then proceed with step 3 below, making sure to update the 

Ipswitch Analytics Server IP address or hostname during the Agent modification process. 

2 Sign in on the Agent machine with administrator privileges. 
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3 Open Control Panel > Uninstall and select Change. 

The installer opens. 

 

4 Click Next. 



 

94 Ipswitch Analytics Installation Guide  

 

Program Maintenance displays. Modify is already selected. Click Next. 

 

5 Enter the Analytics Server Settings. The Agent will forward data from the MOVEit server to the 

Ipswitch Analytics Server that you specify here. 

 Ipswitch Analytics Server IP address or hostname: (From the Tomcat Settings) For example, if you 

entered https://analytics:8443/ura for Ipswitch Analytics Server URL during installation of the 

Ipswitch Analytics Server, enter analytics. 

 Port: By default the Ipswitch Analytics Server is configured to accept HTTPS connections on port 

8443. Adhere to your IT security or other IT network policies when configuring ports.  

 Agent Access Username: Enter the username for the Agent to access the Ipswitch Analytics Server 

(see Installation Worksheet). This user will have the role "Ipswitch Analytics Agent" and no name 

or email is associated with it.  

 Agent Access Password (and confirmation): See Installation Worksheet. 
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Click Next. 

6 Enter the Analytics Agent Truststore Settings: 

 Analytics Server SSL Certificate. Browse to locate the public certificate file for the Ipswitch 

Analytics Server. There are two ways to locate public certificate file for the Ipswitch Analytics 

Server: 

 On the Agent machine: Point a browser to the Ipswitch Analytics Server IP address or 

hostname and when prompted accept the certificate. Then go into your browser's settings to 

manage certificates and export the public certificate associated with the Ipswitch Analytics 

Server. The exported certificate must be in one of the following file formats: .pem, .cer, .crt or 

.der. Place the exported certificate on the Agent machine's desktop or other easily accessible 

location. 

 On the Ipswitch Analytics Server machine: Copy c:\Program Files\Ipswitch\Analytics 

Server\apache-tomcat-7\certs\servercert.pem and place it on the Agent machine's desktop or 

other easily accessible location. 

Important: Do not use the .p12 or .pfx certificate file that you used during installation of the Ipswitch 

Analytics Server. If you select a certificate file that does not have the proper file format, the 

installation will roll back at the point when Ipswitch Analytics files install to the disk and the 

certificate attempts to import to the truststore. 
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 Truststore password: Enter the original truststore password that you used when you first installed 

the Agent. If you deleted the ipswitchcerts file before beginning Agent modification, enter a new 

password here. 

 

7 If the machine on which you are installing the Agent does not contain an installation of MOVEit 

Central or DMZ, select the MOVEit server type for which you are installing this Agent.   

 

Click Next. 
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8 Enter the MOVEit Database Settings.  

 Database Type: Select either MySQL or Microsoft SQL Server, depending on the type of database 

used by the MOVEit server you selected in the prior step. 

 Authentication Type (SQL Server only): Select the authentication type used for logon to the SQL 

Server. The currently used authentication type will be selected automatically. 

 Windows: SQL Server logon will use Windows authentication. If selecting this option, 

username must be entered in the DOMAIN\User format. 

 SQL: SQL Server logon uses a separate user/password created specifically for logon to the 

SQL Server database. 

 Database Name: The name of the MOVEit database. This will be pre-populated if installing the 

Agent on the same machine as the MOVEit server. 

 Hostname or IP Address: The location of the MOVEit database. If the MOVEit database is on the 

same machine as the MOVEit server, this will be localhost. If the MOVEit database and MOVEit 

server are on separate machines, this will be the Hostname or IP address of the machine where the 

database is located. If installing on a machine with no MOVEit DMZ or Central, the default 

database name will appear here (such as moveitdmz).  

Note: If installing the Agent on a machine that contains an SQL Server database with multiple 

instances on the same server, Hostname or IP Address will prepopulate with the default value 

used by MOVEit Central or DMZ (for example, localhost\instance1). You can also enter a 

different instance. If the machine does not contain MOVEit DMZ or Central, the instance name 

will not prepopulate but must be entered manually.  

 Port: The port used to connect with the MOVEit database. The installer suggests a port number, 

but you may change the port number if necessary to match the port used by the MOVEit database. 

This will be pre-populated if installing the Agent on the same machine as the MOVEit server. If 

installing on a machine with no MOVEit DMZ or Central, the default port will appear here. 

Note: If the MOVEit database is using a non-standard port number, you will need to remove the 

default port number shown and replace it with the non-standard port number.  

 Username and Password: The username and password that allows access to the MOVEit database. 

For an SQL Server database: The Authentication Type selected above will determine what user 

credentials you enter here. Windows authentication requires that the username be in the 

DOMAIN\User format. 

Tip: If you can't locate the username and password to the MOVEit database, look in 

c:\MOVEitDMZ_Install.INI file (DMZ) or c:\MOVEitCentral_Install.INI file (Central). 
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Note: The MOVEit database password is protected using standards-based, bi-directional AES256 

encryption. The MOVEit database password is entered in plaintext during the install process and 

is encrypted before being stored in the configuration. When establishing a connection to the 

MOVEit database, the password is decrypted and passed to the JDBC driver. Internally, the JDBC 

driver encrypts the password using a value supplied by the database server before it is transmitted 

to the server for authentication. The plaintext password is never transmitted or stored. 

 

Click Next. 
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9 Change the Agent Display Name if necessary. This name will identify this MOVEit Central server 

within Ipswitch Analytics. The name will appear in the Monitor dashboard and in reports. You may 

want to enter the MOVEit server in this name so it will be easy for users to identify data coming from 

this MOVEit server within the Ipswitch Analytics interface later.  

Important: Agent Display Names must be unique. If an Agent attempts to connect to the Ipswitch 

Analytics Server with a name that is already in use, the connection will be denied, the Agent will not 

appear in the Monitor dashboard, and reports will not contain any data from that Agent.  

 

10 Click Next. 
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11 Review the modifications to the setup: 

 

Warning: If you click Install now, the modification will proceed and you will NOT be able to back out 

your changes even if you click Cancel on the next screen.  

12 Click Install if you are happy with the installation setup, or click Back to make changes to the setup.  

After a few minutes, the modification completes. 

To view the installer log that includes detailed information about ever step of the modification 

process, click Show the Windows Installer log. You can also view the install log at a later point. It is 

located at c:\log.log.  

13 Click Finish.  

Repeat these steps to modify another licensed Agent for a different MOVEit database. 
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This topic describes how to remove the Ipswitch Analytics Server or an Ipswitch Analytics Agent from 

the machines on which they are installed. You might need to remove the Ipswitch Analytics Server (on 

page 101) or remove an Ipswitch Analytics Agent (on page 104) to move them to different machines, for 

instance. 
 

Remove the Ipswitch Analytics Server 

IMPORTANT: If you plan to remove the Ipswitch Analytics Server and then reinstall it later AND you want 

to retain your existing Ipswitch Analytics Server database, follow the instructions here: Remove and 

Reinstall the Ipswitch Analytics Server (on page 103).  

To remove the Ipswitch Analytics Server, first sign in to the Ipswitch Analytics Server machine using an 

account with administrator privileges. 

You can remove the Ipswitch Analytics Server using the Control Panel or the Ipswitch Analytics Server 

installation file: 

Remove the Analytics Server using the Control Panel: 

WARNING: If you remove the Ipswitch Analytics Server via the Control Panel, you will lose your entire 

Ipswitch Analytics Server database.  

1 Open Control Panel > Uninstall a program. 

2 Select Ipswitch Analytics Server from the list and click Uninstall. 

The Ipswitch Analytics Server uninstalls. No further action is required. When the process completes, 

the Ipswitch Analytics Server and its database will be removed from the machine. 

Remove 
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Remove the Analytics Server using the installation file: 

1 Open Ipswitch_Analytics_Base_v1.exe.  

2 Cick Next. 

3 Select Remove. 

4 Click Next. 

A screen appears, warning you that if you proceed, your Ipswitch Analytics Server database data will 

be lost.  

WARNING: If you wish to keep your Ipswitch Analytics Server database and reinstall Ipswitch 

Analytics Server later, cancel the removal now and follow the instructions here: Remove and Reinstall 

the Ipswitch Analytics Server (on page 103), which will show you how to preserve your Ipswitch 

Analytics Server database for later use. You can also visit the PostgreSQL website 

(http://www.postgresql.org/docs/9.3/static/backup.htm) for instructions on backing up your Ipswitch 

Analytics Server database. 

 

5 Click Remove. 

6 After several moments, click Finish. 

The Ipswitch Analytics Server and its database are removed. 

7 Verify that c:\Program Files\Ipswitch\Analytics Server is removed. In some cases this folder may 

remain after a removal. Remove it manually if you see the Analytics Server folder remaining.  
 

http://www.postgresql.org/docs/9.3/static/backup.htm
http://www.postgresql.org/docs/9.3/static/backup.htm
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Remove and Reinstall the Ipswitch Analytics Server 

This topic shows you how to save your Ipswitch Analytics Server database, remove the Ipswitch Analytics 

Server, and then reinstall the Ipswitch Analytics Server. 

1 Shut down all Ipswitch Analytics Agents. Go to each Agent machine and under Administrative Tools 

select Services. Right-click Ipswitch Analytics Agent and select Stop. 

2 Sign in on the Ipswitch Analytics Server machine with administrative privileges. 

3 Go to Administrative Tools > Services, right-click Ipswitch Analytics Server and select Stop. 

4 Back up the Ipswitch Analytics Server database by following the PostgreSQL documentation 

(http://www.postgresql.org/docs/9.3/static/backup.htm). 

5 Remove the Ipswitch Analytics Server. See Remove the Ipswitch Analytics Server (on page 101). 

6 Install the Ipswitch Analytics Server. See Install the Ipswitch Analytics Server (on page 21). 

7 Go to Administrative Tools > Services, right-click Ipswitch Analytics Server and select Stop. 

8 Restore the Ipswitch Analytics Server database by following the PostgreSQL documentation 

(http://www.postgresql.org/docs/9.3/static/backup.htm). 

9 Go to Administrative Tools > Services, right-click Ipswitch Analytics Server and select Start. 

10 Go to each Agent machine, and under Administrative Tools select Services. Right-click Ipswitch 

Analytics Agent and select Start. 

 

http://www.postgresql.org/docs/9.3/static/backup.htm
http://www.postgresql.org/docs/9.3/static/backup.htm
http://www.postgresql.org/docs/9.3/static/backup.htm
http://www.postgresql.org/docs/9.3/static/backup.htm
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Remove an Ipswitch Analytics Agent 

Removing an Ipswitch Analytics Agent will remove all installation files, registry keys, shortcuts and the 

installation directory that were created during installation. The Ipswitch Analytics Server database will 

still contain all data sent from a removed Agent, and because of that, the removed Agent will continue to 

display as an option inside the Template Editor's Filter and inside the Rulesets Filter if data exists for that 

Agent on the Ipswitch Analytics Server. 

 To remove an Ipswitch Analytics Agent: 

1 Sign in on the Agent machine using an account with administrator privileges. 

2 Do one of the following: 

 Open Control Panel > Uninstall and select Uninstall. No further action is required. The Agent 

removal is complete. 

 Open the Ipswitch Analytics Agent installation file and complete the steps below. Make sure you 

select the proper install file: 

 64-bit: Ipswitch_Analytics_Agent64_v1.exe  

 32-bit: Ipswitch_Analytics_Agent32_v1.exe. 

The installer opens. 

3 Click Next. 

4 Select Remove and click Next. 

The Installer is ready to remove the Agent. 

Warning: If you proceed to click Remove, the Agent will uninstall and you will NOT be able to cancel 

it even if you click Cancel on the next screen.  

5 Click Remove.  

6 When the removal is complete, click Finish. 

Note: If you need to reinstall the Agent on this same machine, you must manually remove the 

following folder after removal completes: c:\Program Files\Ipswitch\Analytics Agent. If you cannot 

remove it, terminate any program that may be accessing that directory, such as an antivirus program. If 

you still cannot delete the directory manually, reboot the machine and delete it after reboot.  

If you plan to install an Agent on a different machine that will use the same Agent Display Name as the 

one you just removed, when installing the Agent select Installing an agent already known to Analytics 

Server on the screen where you enter the Agent Display Name.
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